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Abstract

Sudden sensorineural hearing loss (SSHL) is characterized by acute, idiopathic hearing loss. The estimated incidence rate is 5-30 cases
per 100,000 people per year. The causes of SSHL and the mechanisms underlying SSHL currently remain unknown. Based on several
hypotheses such as a circulatory disturbance to the cochlea, viral infection, and autoimmune disease, pharmaco-therapeutic approaches have
been applied to treat SSHL patients; however, the efficacy of the standard treatment, corticosteroid therapy, is still under debate. Exposure to
intense sounds has been shown to cause permanent damage to the auditory system; however, exposure to a moderate level enriched acoustic
environment after noise trauma may reduce hearing impairments. Several neuroimaging studies recently suggested that the onset of SSHL
induced maladaptive cortical reorganization in the human auditory cortex, and that the degree of cortical reorganization in the acute SSHL phase
negatively correlated with the recovery rate from hearing loss. This article reports the development of a novel neuro-rehabilitation approach for
SSHL, "constraint-induced sound therapy (CIST)". The aim of the CIST protocol is to prevent or reduce maladaptive cortical reorganization by
using an enriched acoustic environment. The canal of the intact ear of SSHL patients is plugged in order to motivate them to actively use the
affected ear and thereby prevent progress of maladaptive cortical reorganization. The affected ear is also exposed to music via a headphone for
6 hr per day during hospitalization. The CIST protocol appears to be a safe, easy, inexpensive, and effective treatment for SSHL.

Video Link

The video component of this article can be found at https://www.jove.com/video/53264/

Introduction

Sudden sensorineural hearing loss (SSHL), or sudden deafness, is an idiopathic condition that is characterized by a rapid loss of hearing1.
Several epidemiological studies2,3 reported SSHL incidence rates of 5-30 cases per 100,000 people per year in industrialized countries. Even
though the causes of SSHL and the mechanisms underlying SSHL have been examined extensively, our knowledge on SSHL remains limited.
Among the many potential causes of idiopathic SSHL, common hypotheses include a circulatory disturbance4, viral infection5-7, and autoimmune
disease8,9. Although corticosteroid therapy10 was proposed based on these hypotheses, and is the most commonly applied treatment, the
effectiveness of this standard therapy is still being debated3,11-14. Therefore, innovative SSHL treatment strategies, motivated by different
perspectives, are strongly desired.

SSHL affects neural activity not only in the cochlea, but also in the auditory cortex. Several neuroimaging studies15-17 suggested that SSHL
induced cortical plasticity in the human auditory cortex within a few days of its onset. Moreover, the degree of cortical reorganization represented
by the loss of contralateral hemispheric dominancy of the auditory evoked fields appeared to negatively correlate with recovery rates from
hearing loss18. The cortical plasticity induced by the onset of SSHL may be considered as maladaptive for the hearing capability of the affected
ear. Therefore, the prevention of this maladaptive cortical reorganization associated with SSHL may represent a new treatment strategy.

This article proposes a neuro-rehabilitation approach that prevents 'learned non-use' cortical changes in order to prevent or reduce maladaptive
cortical reorganization. For example, in cases of motor dysfunction, the learned non-use of a limbis a phenomenon in which movement is initially
suppressed due to adverse reactions and the failure of any activity attempted with the affected limb, which eventually results in the suppression
of behavior and corresponding neural activity19,20. Learned non-use does not appear to be limited to motor dysfunction, but may also concern
sensory disabilities21. SSHL patients mainly use and pay attention to the intact ear for listening. This listening behavior appears to increase
neural activity corresponding to the intact ear and, at the same time, reduce neural connections between the affected cochlea and auditory
cortex22. In order to prevent this maladaptive cortical change induced by 'non-use', it appears to be beneficial for SSHL patients to perform
'constraint-induced sound therapy (CIST)'23, which motivates participants to listen to music intensively via the affected ear and to pay auditory
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attention to the affected ear (Figure 1). Compared to conventional pharmacotherapy, the CIST supposedly is a safe, easy, inexpensive, and
effective treatment approach for SSHL.

Protocol

Ethics Statement: Procedures have been approved by the Ethics Committee of the Medical Faculty, University of Muenster, the Ethics
Committee of the Osaka University Hospital, and by the Ethics Committee of the Osaka Rosai Hospital.

1. Preparation of Equipment

1. Obtain ear mold, portable music player, closed-type headphone, equalizer, and headphone amplifier as shown in Figure 2.
2. Prepare libraries of different types of music (pop, rock, classical etc.) on portable music player.

1. Obtain CDs of different types of music.
2. Transfer music from CDs to computer using a sound editing application (e.g., Adobe Audition 3.0 or similar).

1. Place an audio CD in the computer's CD-ROM drive. Choose File > Extract Audio from CD. Choose the maximum speed option
from all the extraction speeds that the selected drive supports.

3. Confirm that the music covers a wide frequency range (i.e., 125-8,000 Hz or wider) using a sound editing application (e.g., Adobe
Audition 3.0 or similar).

1. Select all of a waveform, by choosing Edit > Select Entire Wave. Choose Window > Frequency Analysis. View frequency along
the horizontal axis, and amplitude along the vertical axis in the frequency analysis panel.

4. Transfer music files from computer to a portable music player via a connection cable.
1. Connect portable music player and computer using the USB cable. Save music files in the [MUSIC] folder of the portable music

player as .mp3 files at a bit rate of 192 kbps.

2. Participants

1. Measure hearing threshold levels (air and bone conduction) in both ears using a step size of 5 dB in accordance with the modified Hughson-
Westlake procedure24, by means of a pure tone audiometer.

1. Set the frequency control of an audiometer to 1,000 Hz and set the intact ear to be tested to the earphone.
2. Set the intensity level to 50 dB.
3. Press the sound presentation button for 1 sec to give the patients the 1,000 Hz tone. Wait for their response (e.g., via button press or

hand raising).
4. If the patients respond to the tone, present a 10 dB softer tone in the manner described in step 2.1.3. If the patients do not respond, go

to step 2.1.6.
5. Repeat step 2.1.4 until the patients cannot respond any longer.
6. Present a 5 dB louder tone and wait for the patients to respond.
7. Repeat step 2.1.6 if the patients do not respond.
8. Note the softest intensity level that the patients respond to.
9. Repeat steps 2.1.4-2.1.8 until the same intensity level is noted two or three times. This is the established hearing threshold at 1,000

Hz.
10. Repeat steps 2.1.2-2.1.9 for test frequencies 2,000, 4,000 and 8,000 Hz.
11. Retest the hearing threshold for 1000 Hz and confirm that the first and second thresholds at 1,000 Hz agree within 5 dB.
12. Repeat steps 2.1.2-2.1.9 for test frequencies 500, 250 and 125 Hz.
13. Set the affected ear to be tested to the earphone and repeat steps 2.1.2-2.1.12. Present an appropriate narrowband masking noise

to the untested ear via the earphone using the plateau method25 if the difference between left and right hearing thresholds equals or
exceeds 25 dB in the lower frequencies (125, 250, and 500 Hz), or equals or exceeds 40 dB at or above 1,000 Hz.

14. Measure bone conduction hearing thresholds with masking noise in a similar way as in steps 2.1.1-2.1.13. To measure the bone
conduction hearing, use the bone-conduction vibrator instead of headphones. Apply an appropriate narrowband masking noise25 to the
untested ear in order to avoid crosstalk.

15. Plot hearing threshold levels on an audiogram form. An exemplary audiogram of an SSHL patient is shown in Figure 3.

2. Check the criteria for participation in CIST.
1. Check that the number of days since SSHL onset is less than 5 based on self-reporting.
2. Confirm that the hearing level difference between ears averaged across 500, 1,000, and 2,000 Hz is less than 50 dB based on the air-

conducted pure tone audiogram obtained in step 2.1.
 

Note: In case of the audiogram shown in Figure 3, the hearing level difference is (40 + 40 + 45)/3 - (5 + 0 + 5)/3 = 38.3 dB.
3. Confirm that the patients can comfortably listen to the music with their affected ear.
4. Confirm that the patients suffer from acute unilateral hearing loss (based on self-reporting) and idiopathic condition of acute unilateral

sensorineural hearing loss of at least 30 dB at three or more adjacent frequencies on a pure tone audiogram1 obtained in step 2.1. For
example, in case of the audiogram shown in Figure 3, the hearing levels at and above 250 Hz in the right ear indicate sensorineural
hearing loss of at least 30 dB.

5. Confirm that the patients have no previous history of SSHL based on self-reporting and medical history. Also confirm that they have no
neurological or psychiatric complications based on self-reporting and medical history.
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6. Consider differential diagnoses and exclude the patients who have received other diagnoses such as Ménière's disease26, head
trauma, autoimmune inner ear disease8,9, Cogan's syndrome27,28, genetic diseases29, ototoxic drugs30, retrocochlear disorders related
to vestibular schwannoma31, auditory neuropathy32, or stroke33.

3. Starting CIST

Note: Hospitalization is recommended for the patients' safety. Since the patients are sealed from environmental sounds due to the plugging and
music listening inherent to the CIST procedure, the risk of accidents in their everyday life is expected to increase.

1. Plug the outer canal of the unaffected ear of the patients using an ear mold. Tightly pack the ear mold into the outer canal to ensure that no
space exists in the external auditory meatus.

2. If the patients feel pain or if the sealing is incomplete, remove the ear mold promptly and then reinsert.
3. Ask the patients to choose an enjoyable type of music from the libraries.

 

Note: They are also permitted to listen to their own music if the latter covers a sufficiently wide frequency range (125-8,000 Hz or wider).
4. Ask the patients to wear a closed type headphone. Present the selected music only to the affected ear as shown in Figure 1.
5. Use an equalizer to increase or decrease the sound level of each frequency according to a "half-gain rule", which states that the gain level is

equated to half the amount of hearing level difference between ears at each frequency.
1. For example, if the hearing level differences between ears are X125, X250, X500, X1,000, X2,000, X4,000, and X8,000 at 125, 250. 500, 1,000,

2,000, 4,000, and 8,000 Hz respectively, set the equalizer at 1,000 Hz to "X1000/2 - (X125 + X250 + X500 + X1,000 + X2,000 + X4,000 +
X8,000)/14".
 

Note: In case of the audiogram shown in Figure 3, the equalizer setting for 125, 250, 500, 1,000, 2,000, 4,000, and 8,000 Hz is -5, -3,
0, +2, +2, +5, and 0 dB, respectively.

6. Ask the patients to perform fine adjustments of the sound level and equalizer settings by themselves such that the music sounds as natural
and comfortable as possible. If the internal equalizer of the music player is not sufficiently effective, use a hardware equalizer, as shown in
Figure 2.

7. Ask the patients whether they perceive the music with the affected ear in order to confirm that cross hearing34 does not occur. Exclude the
patients who hear music with the plugged unaffected ear due to cross hearing.

4. Procedure After Starting CIST

1. Instruct the patients that they are permitted to receive standard therapy for SSHL such as corticosteroids in addition to the CIST protocol.
2. Have the patients listen to music for 6 hr per day with the affected ear using the closed-type headphone (Figure 1). Instruct the patients that

the time they spend listening to music can be segmented. Furthermore, allow the patients to perform other tasks (including reading a book
and surfing the internet) during the time spent listening to music.

3. Instruct the patients to use the ear mold all day until they leave the hospital.
4. Measure the air conduction threshold levels of the affected ear every two days in the same way as in step 2.1. Adjust volume and equalizer

settings as mentioned in steps 3.5 and 3.6.
5. When the patients are discharged from hospital and when they return as outpatients, measure the hearing threshold levels in the same way

as in step 2.1.

5. Cessation of CIST

1. Remove the ear mold if the patients report discomfort regarding the plugged intact ear (such as tinnitus or pain).
2. Measure hearing threshold levels in the intact ear in the same way as in step 2.1.
3. Stop the CIST procedure if the hearing levels averaged across 500, 1,000, 2,000 Hz obtained in step 4.4 and/ or 5.2 deteriorate more than

5 dB compared to those obtained in step 2.1. For example, in case of the audiogram shown in Figure 3, the hearing levels averaged across
500, 1,000, 2,000 Hz are (40 + 40 + 45)/3 = 41.7 dB in the affected ear and (5 + 0 + 5)/3 = 3.3 dB in the intact ear.

Representative Results

Twenty-two SSHL inpatients who matched the criteria described in the protocol and who were willing to receive CIST were assigned to the target
group, which underwent CIST in addition to standard corticosteroid therapy (CIST + SCT group)23. The control group consisted of 31 SSHL
inpatients who only received the standard corticosteroid therapy (SCT group). All participants were fully informed about the study and gave
written informed consent in accordance with procedures approved by the Ethics Committee of the Medical Faculty, University of Muenster, the
Ethics Committee of Osaka University Hospital, and by the Ethics Committee of Osaka Rosai Hospital. This study was performed in accordance
with the Declaration of Helsinki. Participants in each of the two groups (SCT+CIST vs. SCT) had similar ages and time delays between the
occurrence of SSHL and the initial audiogram.

The hearing thresholds of all participants were measured (i) before the treatment (1st examination), (ii) at discharge from the hospital (2nd

examination: time interval between the 1st and 2nd measurements (mean ± standard deviation (SCT+CIST: 9.41 ± 3.14 days, SCT: 10.42 ± 3.18
days), and again (iii) a few months later (3rd examination: mean ± standard deviation (SCT+CIST: 63.45 ± 28.56 days, SCT: 84.64 ± 38.68 days))
using a pure tone audiometer.
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As shown in Figure 4, before the treatment (1st measurement), no significant differences were observed in hearing thresholds between
groups at all measured frequencies (125, 250, 500, 1,000, 2,000, 4,000, and 8,000 Hz) in the affected ear. After the treatment (2nd and 3rd

examinations), hearing in the affected ear had improved at all frequencies in both the SCT+CIST and SCT groups (Figure 4). The hearing
threshold levels across all frequencies were averaged for each ear separately and then hearing level differences between ears were calculated
(Figure 5). The hearing level differences between the affected and intact ears were attributed to SSHL. The calculated hearing level differences
between the ears were similar between groups before the treatment at the 1st examination (Figure 5). However, significant differences were
observed between the two groups at discharge from the hospital (2nd examination: P <0.05 (Bonferroni-corrected)) and at a few months later
(3rd examination: P <0.001 (Bonferroni-corrected)). Regarding hearing levels in the intact ear, the mean thresholds did not significantly differ
between groups at any of the frequencies in any of the three examinations. This result indicated that plugging the ear canal did not appear to
have a negative effect on the intact ear. In the 22 participants who underwent CIST, apparent side effects were not observed.

 

Figure 1. Schematic illustration of constraint-induced sound therapy (CIST). The canal of the intact ear is plugged in order to motivate
usage of the affected ear. Music is monaurally presented to the affected ear via a closed-type headphone; the other channel corresponding to the
intact ear is kept silent (This Figure has been adapted from Okamoto et al.23: Drawing courtesy of Lothar Lagemann.).

https://www.jove.com
https://www.jove.com
https://www.jove.com


Journal of Visualized Experiments www.jove.com

Copyright © 2016  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

January 2016 |  107  | e53264 | Page 5 of 10

 

Figure 2. Connections and devices to use in CIST. A portable music player, equalizer, headphone amplifier, and closed-type headphone
are sequentially connected. Equalizer and headphone amplifier are used only when the digital equalizer of the portable music player is not
sufficiently effective. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com
https://www.jove.com
https://www.jove.com/files/ftp_upload/53264/53264fig2large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2016  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

January 2016 |  107  | e53264 | Page 6 of 10

 

Figure 3. An exemplary audiogram of an SSHL patient. This Figure represents the hearing levels (range: 125 to 8,000 Hz; one octave
steps) in the affected ear (Air conduction: open circles; Bone conduction: left square brackets) and the intact ear (Air conduction: crosses; Bone
conduction: right square brackets) of an SSHL patient before the treatment. Please click here to view a larger version of this figure.
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Figure 4. Time course of mean hearing level in affected ear. This Figure shows the mean audiograms (range: 125 to 8,000 Hz; one octave
steps) in the affected ears of the participants who underwent constraint-induced sound therapy in addition to receiving standard corticosteroid
therapy (CIST + SCT: open squares) or in those who only received standard corticosteroid therapy (SCT: filled squares). The 1st, 2nd, and 3rd

audiometric examinations were performed (i) before the treatment, (ii) at discharge from the hospital, and (iii) a few months later, respectively.
The error bars denote 95% confidence intervals (This Figure has been modified from Okamoto et al.23). Please click here to view a larger version
of this figure.
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Figure 5. Mean hearing level difference between ears. Hearing threshold differences between affected and intact ears were averaged across
all measured frequencies at the 1st (left: before the treatment), 2nd (center: at discharge from hospital), and 3rd (right: a few months later) pure
tone audiometric examinations. The open and filled squares denote the constraint-induced sound therapy + standard corticosteroid therapy
group (CIST + SCT) and the standard corticosteroid therapy alone group (SCT), respectively. The error bars denote the 95% confidence intervals
(This Figure has been modified from Okamoto et al.23). Please click here to view a larger version of this figure.

Discussion

This article describes a behavioral treatment approach for SSHL. The CIST protocol merely requires the use of easily available devices. A
comparison of the treatment effects of CIST + SCT with those of SCT alone revealed significantly better hearing improvements with the CIST +
SCT treatment. No apparent side effects were associated with the CIST protocol. The cost of CIST is markedly lower than other newly suggested
treatments (including a stellate ganglion block and hyperbaric oxygen therapy). The CIST protocol represents an effective, inexpensive, easy,
and safe treatment for SSHL; however, several important points must be considered. One point is the prevention of acoustic trauma. Although
the maximal volume settings of recent commercial portable music players are limited to remain below the harmful levels, the sound level needs
to be observed when a large adjustment is made to the equalizer settings or when a headphone amplifier is used. The second point is 'cross
hearing'. The purpose of the CIST procedure is to enable SSHL patients to actively use their affected ear for listening. When patients develop
severe hearing loss, they may still hear sounds with the intact ear despite plugging. The third point is 'accidents'. In the case of traditional
pharmacotherapy, the intact ear is not plugged, and thus SSHL patients can pick up environmental sounds via this intact ear. On the other
hand, plugging and music listening inherent to the CIST protocol seal patients from environmental sounds, and thus the accident hazard is likely
increased. Therefore, the CIST protocol should be conducted in a safe environment.

Unlike pharmacotherapy, the CIST protocol has no limitations concerning medications, allergies, or other diseases such as diabetes,
hypertension, and hyperlipidemia. However, the limitation of this protocol is that it is intended for patients who are able to listen to sounds with
their affected ear. As such, the CIST protocol is not suited for SSHL patients with severe hearing loss. This protocol is applied to acute stage
SSHL (days since SSHL onset ≤ 5) because previous studies reported that a shorter time delay between the onset of SSHL and the start of
treatment led to better hearing recovery2. It remains elusive whether there is a time restriction for starting the CIST protocol. Moreover, the
optimum duration of the CIST protocol and the total music listening time require further investigation.

This protocol utilizes the corticosteroid therapy in addition to CIST. At present, corticosteroids are the most commonly used treatment for SSHL,
and therefore it is ethically not feasible to stop this treatment. However, recent triple-blinded SSHL treatment studies14 revealed that the recovery
of non-treated patients was similar to that of patients who had received corticosteroids. Even though one cannot exclude the possibility that the
combination of CIST + SCT led to the results obtained, it appears reasonable to assume that CIST alone will be beneficial, especially for patients
with diseases that are worsened by corticosteroids such as infections, diabetes, and glaucoma.

In this protocol, patients are hospitalized in order to avoid accidents. However, SSHL patients often cannot be hospitalized because of work,
family, and financial reasons. The utilization of a hearing aid may allow these outpatients to perform the CIST protocol. SSHL patients who
wear a hearing aid in their affected ear are 'functionally' exposed to an enriched acoustic environment, are not in danger to be exposed to
harmful sound levels, and are able to detect warning sound signals. However, the daily monitoring of hearing threshold levels and appropriate
adjustments to the hearing aid settings would be necessary since hearing capability of SSHL patients can improve rapidly. Generally, the CIST
protocol will not disturb other treatment approaches and may actually manifest a synergic effect when used in combination with other SSHL
treatment strategies.

In the present study, a limited number of SSHL patients underwent the CIST protocol, and the participants were not randomized to the different
treatment conditions. Thus, a randomized controlled study including a larger number of patients should be executed in the future. Moreover,
the effectiveness of the CIST protocol should be investigated in patients with different types of hearing loss. Further, in the present study, all
participants who performed the CIST protocol also received the corticosteroid therapy. Therefore, it remains unresolved whether the CIST
protocol alone can improve the hearing ability of SSHL patients. It would be valuable to perform a randomized controlled study in which SSHL
patients, for whom corticosteroids may cause severe side effects (such asinfectious diseases or diabetes mellitus), would either merely receive
the CIST protocol or merely a standard corticosteroid therapy. Notably, in our previous report23, the effects of the CIST protocol within the human
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auditory cortex were examined by means of magnetoencephalography35. The results showed that the CIST protocol could have prevented
maladaptive cortical reorganization in the human primary and non-primary auditory cortices. Of course, it is difficult to conduct neuroimaging
studies in practices and hospitals; however, speech test, hearing in noise test36, and tinnitus related examinations37 may contribute to reveal
the functional plasticity in the central auditory system induced by the CIST protocol. Eventually, even though the CIST protocol is in a very early
stage in development, and although further investigations are needed, the CIST protocol as an effective, inexpensive, and safe treatment option
can complement the corticosteroid therapy, which may induce severe and potentially lethal side effects.
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